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System Requirements 
PC Windows: 
6Mb of free Hard Disk Space. 
Microsoft Windows 95, 98, Me, NT4, 2000 or XP. 
 
Apple Mac  
System 6, 7, 8 or 9 
Power PC upwards 
 
Acorn  
RISC OS 3 or above 
2Mb RAM 

 

Installing Flowol 
PC Windows: 
Current Flowol users: Please refer to the notes below before commencing installation.  
 

Close any open programs - you will need to restart your machine for configuration 
changes to be made after Flowol is installed.  
 
USB Users: Make sure that the device (FlowGo or SOLO) is not connected to the USB port during installation. 
Note for  Windows NT, 2000, XP users: This program should be installed with Administrative Privileges on the 
system. 
 

·  Insert the Flowol 2 CD ROM into the CD Drive. This is an auto play CD ROM, so 
Windows should detect the presence of the CD and automatically start up the Auto 
run program.  
Note: If the Auto run program fails to start, use Windows Explorer to navigate the CD ROM contents 
and double click on the file Setup.exe.  

·  Follow the on-screen instructions to complete the installation of Flowol and its 
associated files onto the hard disc.  

·  When installation is complete, eject the CD ROM and store safely.  
·  RESTART your system. 
 
PC Flowol 2 network installation instructions: see Appendix I (page 35).  
 
Notes for  current Flowol users: 
If you have an earlier version of Flowol on your computer it is best removed before 
commencing installation. To uninstall Flowol Version 2.81 or lower use Uninstall from 
within the Programs/Flowol 2 part of the Star t menu. If this method is used to uninstall, any 
existing mimics will remain on your system in the Flowol directory (default location 
C:\DHG\Flowol\Mimics). If Flowol 2.9 (default location C:\Program Files\Keep I.T. 
Easy\Flowol 2) is installed to the same directory as the previous version all existing mimics 
will work. Alternatively either copy & paste all the contents of the existing Mimic folder into 
the Mimic folder in the new directory or reinstall the mimics using the original Mimic discs. 
 
USB Users:  
You must uninstall any existing USB drivers for the FlowGo interface prior to installing 
Flowol 2.9.  The Flowol 2.9 installer will not start if the old drivers are detected. 
Remove the old drivers by opening the Control Panel (via Start/Settings), choose 
Add/Remove programs, and remove the �FlowGo USB Drivers�. Follow the on screen 
instructions to remove the drivers.    
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Flowol Version 2.9 or higher will install the latest USB drivers for FlowGo and 
SOLO to your hard drive as part of its installation. You must restar t your  system 
after Flowol has been installed before connecting the FlowGo or SOLO device. 
 
Connect the FlowGo or SOLO device to the USB port. Either the hardware 
information database will automatically be updated or a wizard will be generated to 
aid installation (depending on your operating system).  
 
Windows XP users: You may be warned that the drivers have not passed Logo signing, please 
�continue anyway� at this point. 
 

Apple Mac: 
USB Users: Make sure that the device (FlowGo or SOLO) is not connected to the USB port during 
installation. 
 

·  Insert the Flowol 2 CD ROM into the CD Drive.  
·  Install Flowol by copying the Flowol files from the CD into a folder on your 

hard/boot disc drive. 
·  USB FlowGo/SOLO Users: Copy the USB driver file 

[USBSerialConverter_0403FE59] into the Extension folder in System on the 
hard/boot disc drive.  

 
Note: SerialShimLib (an Apple supplied library) must be available in your Extensions folder for 
these drivers to work.  
 

Acorn RISC OS: 
To Install to Hard disc: 
Place the Flowol disc in drive :0 
Click on the floppy disc icon. 
Double click on the !Flowol icon  
in the filer window. 
Follow the on screen instructions. 

 
Note: It is strongly recommended that Flowol is installed to the Hard Disc.   When Flowol is run from 
floppy disc, the Mimics will NOT be available. 

 
Getting Star ted  
To start the Flowol software (once it has been installed). 
 
PC Windows: 
Click on the Star t button on the taskbar. 
Within Programs, select Flowol 2.90 and click on the Flowol 2 icon.  
 
Apple Mac: 
Double click on the Flowol2 icon on your hard disc. 
   
Acorn RISC OS: 
Double click on the Flowol2 icon on your hard disc. 

 

To Run from Floppy disc: 
Place the Flowol disc in drive :0 
Click on the floppy disc icon. 
Double click on the !Flowol icon 
in the filer window. 
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Configur ing Flowol  
Flowol can operate with or without an interface attached. If the ‘No Interface’  option is 
selected, Flowol will automatically be in simulation mode with the maximum number 
of inputs and outputs available. If an Interface has been selected from the list then 
Flowol can operate either: 
 

·  Without the interface connected (in simulation mode) so that the correct number 
of outputs, inputs and the commands available for that interface are available or 

·  With the interface connected (with simulate deselected). 
 
The following inter faces can be supported: 
Data Harvest: Contact Controller Plus 
   Contact Controller 
   Sense and Control (used to operate the Control Interface or Buffer Box). 
   Kids Chip P.I.C. System 
   FlowGo (Windows and Apple Mac only) 
   Solo (Windows only) 
 

Fischertechnik:  Intelligent Interface (Windows and Apple Mac only) 
 

Deltronics: Serial Interface 
   Serial Interface + 
   Junior Interface 
   Extra Sense [Serial Interface] to operate the Control IT Buffer Box. 
   Digital Serial Adapter: to operate the Control IT Buffer Box. 
 

Commotion: Serial Interface 
   Junior Interface 
 

LEGO DACTA: (Control Lab) Interface B (Windows and Apple Mac only). See Appendix II  
 

Unilab:  MFA Serial Interface 
   
User Port Upgrade (Acorn only) will control Control IT Buffer Box and Sense IT (with an ADC). 
 

To set the Inter face:  
PC and Mac, select Interface from the Control menu. 
Acorn users, select Interface from the Icon bar menu. 

 
Leave Simulate from the Control menu ticked until you 
have made the interface and communication port 
selection.  
 
Select either: 
[a] No Interface and then [e] OK and Save 

or  

[b] Serial port if simulating or using an interface. 
Then 

·  Select the model of interface being simulated or 
used from the list [c].  

[c] 

 

[a] 

[b] 

[d] 

[e] 



 

 

Flowol Tutorial Primary & Secondary 

Page 6 © Keep I.T. Easy 1997 Flowol 

·  Select [d] the appropriate communication port e.g. Com port 1 – 6 or USB (Windows 
version), Modem/Printer or USB (Mac version), Serial or User/Printer port (Acorn 
version). 

 

·  Select the labelling (0–7) if required (Tutorial is written for 1–8 setting) 
 

·  Select the High / Low state if required (This usually sets automatically). 
 

·  Select any secondary control interface (i.e. the appropriate board for Kids Chip or 
SOLO, the output module on the MFA Serial Interface or that on the Sense & 
Control). 

 

·  Select the sensing interface (for the Acorn only with an analogue port). 
 

·  Select OK and Save for Flowol to save your selection so that it will be 
automatically configured when next used, or OK for these settings to be used for 
this session only. 

 

·  Untick Simulate from the Control menu. 
 

 

The Tutor ial 
Introduction. 
This tutorial introduces Flowol software and the flowchart method of creating a control 
program.  It is a hands-on approach that puts the reader through a series of exercises.  
Each exercise uses a control program to explore different elements of control, starting 
with simple ideas and progressing to more complex examples.  The features of Flowol 
are introduced gradually at each stage. 
 
Using the Tutor ial. 
The first section is an appropriate introduction for both primary and secondary 
(see page headers). Pages 16 – 20 use mimics from the Primary Mimic disc and 
are targeted at primary level.  Pages 21 to 26 use mimics from the Secondary 
Mimic disc and are targeted at secondary level.   
 
Each theme in the tutorial usually gives clear direction to possible solutions.  Ideas need 
to be transferred from one area to another and extended to provide a complete solution. 
 
Why Flowol? 
Flowol can be set to operate in simulation mode.  It allows all students on a computer 
to actively create, test and modify their control solutions.  The mimics respond in a 
realistic way and the visual activity of the flowchart allows the logic to be easily 
followed and amended. 
 
When models are connected and controlled through an interface, the mimics still 
respond. When readings from analogue sensors are logged and used to control events 
then the computer screen becomes an important monitoring tool. (Industrial processes, 
security system etc are monitored in a similar way). 
 
 
 



 

 

Tutorial Flowol Primary & Secondary 

© Keep I.T. Easy 1997 Flowol Page 7 

The Screen 
 
 
The Workspace. 
Flowol has a workspace that represents up to 4 x A4 
sheets of paper, when printed.  There is sufficient 
space to create a program with 220 symbols. 
 
The Toolbar . 
i) Click on a Tool/symbol to select it. 
ii) Click again on the workspace to position it. 
iii) A prompt box will appear at the bottom of the 

window.  It contains all the items that can be 
entered into that symbol.  Some buttons are 
highlighted and others are dormant to avoid 
syntax errors. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Graphs. 
i) Analogue and digital inputs can be logged as a 

separate application. 
 
ii) Inputs and outputs can be plotted together to 

show the response of the controlled outputs. 
 

 
 
 
 
 
 
 

 
 

 

Mimics.  
Allow the programs to be developed 
and tested in ‘Simulate’  mode 
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The Toolbar  

 

 

 

 

ERASE The Erase Tool will highlight and become active when part of the 
flowchart has been selected for editing. 

Star t/Stop/Sub Use the Star t symbol at the beginning of the flowchart program. 
Use the Stop symbol at the end of a sub-routine, and at the end of a 
program that is not recursive (repeating). 
Use the Sub symbol to head a sub-routine. (Note: sub-routines should be 
defined before the main program). 
Use the prompts to make your selection. 

Output Use the Output symbol to turn on or turn off an output or a motor. 
Use the prompts to make the selection. (Note: up to four outputs can be 
turned on or off at a time within one symbol or two motors). 

Process Use the Process symbol to put in a delay. (How long does the output 
need to be switched on for?). 
This is also used to call a sub-routine, or to set up a variable.  Use the 
prompts to make your selection. 

Decision Use the Decision symbol to decide if  ‘Yes do this’  or  ‘No do that’ . 
It is used to check for feedback from an input signal such as: is the 
switch on, or is the temperature value more than, less than or equal to x 
etc. 
This symbol can also be used to check the values of a variable.  Use the 
prompts to make your selection. 

Click on the Text Tool to add a title, or comments on the flowchart.  A 
dialogue window will open into which text can be entered.  There is a 
choice between small, medium and large text. 

Text 

T 

 

Edit Click on the Edit Tool (or use right mouse button) when you need to 
highlight symbols, lines, labels or section of flowchart.  They can then be 
erased, changed or moved. 

Use the L ine Tools to link the symbols together to create the flowchart. 
Where a decision symbol has been used, then both a YES and a NO line 
have to be selected. 
 E.g. If switch is pressed (Yes)         - do something. 
        If switch is not pressed (No)    - go back and check again. 

YES 

NO 

 

A ‘download’  button will appear at the bottom of the toolbar if the selected 
Interface is Kids Chip PIC system, FlowGo or SOLO. 
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Zebra Crossing 
Mimic 
Zebra. 
Resource 
6V bulb connected to Output 1 
 
 
Program: 
1 Select the Star t symbol ‘Tool’  and position it on the workspace.  

Use the prompts to select Star t. 
 
2 Select an Output Box – position it under the Start symbol. Use the 

prompt to Select: Turn, Output, 1, on, click on OK. 
 
3 Select a Process Box – position it under the Output box. Use the 

prompts to select Delay 5. Click on OK.  
Note: Delays are in seconds and can be from 0.1 to 999. 

 
4 Select the Output Box – position it under the symbol above.  Use 

the prompts to select Turn, Output, 1, off. Click on OK. 
 
5 Select a Stop symbol – position it under the symbol above.  Use the 

prompts to select Stop. 
 
6 Select the L ine tool to link the symbols 

i) Click on the ‘Start’  symbol (it will highlight green). 
ii) Click on the symbol beneath it (the line will be drawn). 
iii) Click on the second symbol (this is the start of the next line) 
iv) Click on the third symbol and continue until the flowchart is complete. 

 
To run this short program, click on the Red RUN symbol in the toolbar. To stop the 
program running click on STOP or press ESCAPE. 
 
 
To open up the mimic: select 
Mimic from the Window 
menu. Choose ‘Zebra’ , tick 
‘Show Labels’  and click on 
OK. [Test the action of the 
mimic: click on one of the 
crossing lights to turn it on, 
click again to turn it off]. 
RUN your program again. 
 
To save a program, open the File 
menu, then click on Save. Flowol 
follows the standard saving procedure 
for whichever computer you are using. 
Now save your  program – Call it 
flash. 
  

Skill: To connect three of the basic flowchart ‘Tools’  to create a 
control program to light a bulb for 5 seconds, then switch it off. 
 

 

Start

Turn
 Output 1 on

Delay 5

Turn
 Output 1 off

Stop
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Editing a flowchar t. 

Skill:  To modify a flowchart  
i) Remove unwanted symbols 
ii) Changing information in the symbols 
iii) Adding extra symbols in a sequence 
iv) Changing the flowchart colours 
 

Mimic 
Zebra  
Resources 
6V bulb connected to Output 1 

Removing a mistake:  
Symbols or lines in the wrong place can be removed. 
 
Select the Edit tool (Hand).   
Note: the right mouse button is an edit short cut, instead of clicking on ‘Hand’  
 
Click on the incorrect line or symbol to highlight it, and then click on Erase at the top of 
the toolbar. 
  

 

Changing Information: 
1 Select the Edit tool (Hand). 
 
2 Click on the ‘Delay’  in the 

Flowchart to highlight it. 
 
3 Click on ‘Clear’  in the 

prompt box and change to 
Delay 2, OK. 

 
Inser ting Additional Symbol: 
1 Select another process 

symbol from the toolbar. 
2 Place it on the line above the 

Stop symbol. The chart will 
automatically re-draw itself. 

3 Use the prompt box to select 
Delay 2, OK. 

 

To make the Zebra crossing flash forever  (recursive): 
1 Select Edit tool, click on the Stop symbol and erase it. 
2   Re-draw the line from the second Delay to the process 

symbol turning on output 1. 
 
Now save your  program – call it flashes. 
 
Nothing happens to the model.  Flowol is set to operate 
in Simulation mode. To use an inter face, select Interface 
from the Control menu, choose the interface you are using 
and then return to the Control menu to ‘un-tick’  Simulate. 

 

Start

Turn
 Output 1 on

Delay 2

Turn
 Output 1 off

Stop

Start

Turn
 Output 1 on

Delay 2

Turn
 Output 1 off

Stop Delay 2

Start

Turn
 Output 1 on

Delay 2

Turn
 Output 1 off

Stop

Change delay

insert extra process

Erase this Stop & draw new line

To change the colours of the flowchart: Select ‘Colour options’  in the Window menu.  
Stronger colours may be useful for demonstrations but strong, flashing colours can be 
hazardous. 
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The L ighthouse 

Skill:   To use multiple flowcharts: 
i) Move sections of flowchart. 
ii) Copy flowcharts. 
iii) Label parts of the flowchart. 

Mimic 
Lightho  
 
Resources 
Output 2 - buzzer 
Output 1 – 6V bulb 

 

Re-load the Flashes program and run it with the lighthouse mimic.  
 
Moving Sections of the flowchart: (individual symbols or as groups) 
1 Select the Edit tool (hand). 
2 Click on the symbol in the flowchart to be moved, it will highlight. 
3 Use the left mouse button to drag the symbol and then release. 
4 To highlight a group of symbols, drag a box around the group. (Click left mouse 

button at one corner of the group, drag a box across them and release).  
5 Select any one of the highlighted symbols to drag the group.  

Adding a Fog Horn to the lighthouse: 
 
1 The sequence for the foghorn is similar to 

that of the main light. 
 
2 Copy the ‘Flashes’  flowchart: 

i) Select edit tool and highlight the entire 
flowchart by dragging a box around it 
(explained above). 

ii) Hold the Shift key and drag one of the 
highlighted symbols to drag a copy of 
the flowchart to one side, release 
mouse button. 

 
3 The outputs in the second flowchart now 

need to be re-defined as Output 2.  
 
4 It may also be advisable to change the 

delays: Delay 1 when buzzer is ‘on’  and 
Delay 3 when ‘off’ . 

Labelling the Flowchart: 
Select the Text Tool, position and click the ‘marker’  on the flowchart.  
Write the label in the text window at the bottom of the screen. 
Select the size of font required and click on OK. 
Labels can be edited and moved in a similar way to that of the symbols. 
To align the headings, drag a box to highlight them and select ‘Align’   (Edit menu). 
 
Now save your  program – call it Fog 

 

Start

Turn
 Output 2 on

Delay 1

Turn
 Output 2 off

Delay 3

Start

Turn
 Output 1 on

Delay 2

Turn
 Output 1 off

Delay 2

Output 1 to 2

Change the Delays

Main Light Fog Horn (buzzer)
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Lighthouse with a switch 

Skill:   Changing the size (scale) of the flowchart 
 Using an Input  (Decision box). 
  

Mimic 
Lightho 
Resources 
Output 3 – 6V bulb 
Output 2 – buzzer 
Output 1 – 6V bulb 
Input 1 – switch or LDR 

 

 

 

Re-scaling the flowchart to get more 
space: 
1 Load the lighthouse ‘Fog’  program. 
2 Choose Scale View from the 

Window menu. 
3 Change the scale, as a % (i.e. 80%). 
4 Click on Scale. 

Using an input switch to control the interior lights: 
 
1 An input is observed by a decision symbol.  When the 

program is running the decision instruction ‘ looks’  for a 
fraction of a second to see if the input is On or Off. 

 
2 Build the procedure shown in the diagram to your ‘Fog’  

program.  When you select the line tool you must use the 
Yes and No. Just click on the ‘source’  and then on the 
‘destination’  symbols as explained before and the lines will 
be drawn. 

 
3 Label this part of the program with as much detail as 

possible.   Now save your  program (choose a name). 

Using a light sensor  (LDR) as the switch 
 

1 If a light sensor is On when it is light and Off 
in the dark, modify this part of the program to 
turn on the interior lights when it goes dark. 
Save your  new program. 
Click on the Moon/Sun on the mimic to 
simulate input 1 (Moon for Off, Sun for On).  

 
2 Try to add a decision symbol to the other 

flowcharts so that the main light or foghorn is 
also controlled automatically. 

 
Test your  program and save it. 

 

Note: Flowol 2 can support 20 flowcharts 
running simultaneously. 

 

Start

Is Input 1 on

Turn
 Output 3 on

Turn
 Output 3 off

NOYES
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Traffic L ights 

Skill:   Simulations with monitor screens. 
 Multiple outputs in a symbol. 
 Drawing ‘ flow lines’  manually. 

Mimic 
Bridligh 
Resources 
Output 3 – 6V bulb 
Output 2 – 6V bulb 
Output 1 - 6V bulb 
 
 

 

Simulation without a mimic. 
Flowol has two monitor screens that are accessed 
from the Window menu.   
Both show the state of the inputs and outputs.  
Clicking on their input numbers will simulate the 
inputs, providing the program is in simulate mode. 
(Simulate ticked in Control menu).   
 

Large Monitor  screen can have the inputs/outputs labelled (click on the label and re-write).   
This is useful to simulate: traffic lights, pelican crossing, lighthouse, etc. OR to have as 
reference when building a program. 
(There is also an analogue inputs monitor screen, which should be closed at this stage). 
 
Small Monitor  screen will always appear at the bottom of the window when the program is 
running if the large monitor screen has not been opened. 

 

Traffic L ights: 
1 Open the Large Monitor screen, and label some 

of the outputs, as explained above. 
 
2 Scale View the screen to 80% or less. 
 
3 Build up the flowchart as shown.  

 
Star t a new column and work down. 
Multiple outputs can be triggered in the same 
output box; follow the prompts (up to 4 outputs 
can go in each output box). 
The final line is drawn manually to avoid a 
‘cross over’ . 

a. Select the line tool. 
b. Click on the last output box. 
c. Click for the first corner for the line. 
d. Click for the second corner. 
e. Click where the new line meets the existing 

line. 
f. Click on the ‘Delay 7’  symbol. 

Start

Turn
 Output 3 on

Delay 7

Output
 2 on 3 off

Delay 3

Output
 1 on 2 off

Delay 7

Output
 2 on 1 off

Delay 3

Output
 3 on 2 off

Line drawn manually
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Double Traffic L ights  

Skill:  
i) Modify and Edit flowchart. 
ii) Click on the mimic to test its 

function. 
iii) Click on the mimic labels when 

building the flowchart 
iv) Using ‘Hot Keys’  
v) Auto-Scroll 
vi) Slowing down the flowchart 

  

Mimic 
Bridligh 
Resources 
Outputs (1 to 6) – 6V bulbs 

 

Single Set of L ights: 
The light sequence on the previous 
page is not quite right. Make the 
correction and save it as 3lights. 
 
Testing the Outputs on the 
Mimics: 
1 Re-label the large monitor screen 

for the second set of lights.  
2  Display Traffic mimic with 

‘Show Labels’  ticked.  
3 If you carefully click on each of 

the lights on the mimic you will 
make them turn on, click on 
them again to turn them out.  
Check the labels on the monitor 
screen. 

 
 

Double Set of Traffic L ights 

1 The sequence for the single set of lights now needs to be modified. Extra symbols can be 
inserted or some of those already there can be highlighted and edited, e.g. use the prompt box 
to ‘Clear’  and then re-write the instructions (up to four outputs can be in each symbol). 

 
2 Drawing the flowchart with the help of the mimic.  When building the command:  

Turn output 3 off output 2 off output 1 on, it is possible to click on the appropriate labels on 
the mimic to refer to the outputs but the On Off and OK still on the prompt window. 

 
3 Using the Hot Keys. Letters and symbols in the PC prompt boxes are underlined e.g. 

Turn output 1 etc, which refers to the keyboard keys that can be used instead. [The initial 
letter will do the same on the Mac or Acorn versions]. 
Some instructions have different letters e.g. ‘on’  and ‘off ‘are Yes and No. 
OK is Enter or Return. (Combine the use of mimic labels, hot keys & prompts). 

 
4 Auto-Scroll:  Choose ‘Auto Scroll’  from the Edit menu. Choose again to turn it off.  
 
5 Reducing the Speed of the Flowchart: is sometimes useful when demonstrating or checking 

for errors. Select the ‘Speed’  from the Control menu and adjust the slider. Using ‘Space bar’  
allows you to ‘step’  through the flowchart.  
[Note: Not suitable for use with Kids Chip]. 
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Sub 1(stop)

Output
 2 on 1 off

Delay 2

Output
 3,7 on 2,8 off

Delay 8

Output
 3,7 off

Stop

Sub 2(flash)

Output
 2,7 on 

Delay 0.5

Output
 2,7 off

Delay 0.5

Stop

Start

Output
 1,8 on 

Is Input 1 on

Sub 1(stop)

Sub
 2(flash) x 5

Pedestrian/Pelican Crossing

YES

NO

Pelican Crossing 

Skill:  Using Sub-routines. 
 Repeating sub-routines. 
 Run what? 

Mimic 
Pelican 
Resources 
Outputs (1 to 8) – 6V bulbs 
Input 1 - switch 

Pelican Crossing with Sub-routines 
When a ‘string’  of symbols gets too long, it 
is better to split them into sub-routines and 
command them from a main routine.  
Note: The program repeats Sub 2, five times. 

 
Build the Program 
1 Draw and define the sub-routines first. 

(Click on Sub and write the name in the 
text window before clicking OK). 

   
2 Draw the main routine (with a ‘Start’ ). 

Select the process box and click on ‘Sub’ , 
a list of routines will appear, make your 
selection, to repeat this sub-routine, click 
on a number before clicking on OK. 

 

3 Develop the program to: 
Use Output 5 to indicate the need to WAIT. 

 
4 Save your  programs at each stage. 

 
5 Run and click the button on the mimic. 

 

Flowol can support a total 
of 50 Sub-routines. 

 

Run what?  Allows you to test a sub-routine 
or selected flowcharts on their own. 
Select ‘Run what?‘  from the Control menu; 
choose your sub-routine and RUN. 
Or choose ‘Selection’  from menu; highlight 
the chosen Start on your flowchart and RUN.   
Choose ‘All Starts’  at the end of the test. 
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Stop All  

 

1. Load the Robot mimic and open the small 
monitor window. 

2 Using the mouse, click on the ‘ input’  
shapes on the front of the robot and 
observe the monitor screen. 

3 Click on the robot’s mouth, each eye and 
the top of the aerial.  Click again to 
reverse the effect. When are the outputs 
on or off?  

4 Flowcharts can be drawn using the 
coloured buttons. Click on the button 
once to press it and then click again to 
release it.  

Start

Is Input 3 on

Stop All

YES

NO

Start

Is Input 4 on

Turn
 Output 1 on

Turn
 Output 1 off

YESNO

Start

Is Input 1 on
Turn

 Output 2 on

Output
 3,4 on 

Delay 2

Turn
 Output 3 off

Delay 3

Output
 2,4 off

YES

NO

Input 1 (green) will set a 
sequence of events in action 

Use Input 4 (blue) to lift 
up the aerial (Output 1). 

Skill:  
Clicking on the mimic to check the 
inputs and outputs. 
Using the ‘Stop all’ . 

 

Primary Mimic Disc 
Robot 

The Robot 

Input 3 will act like an 
emergency stop (‘Stop All’ ).  
The whole program will stop 
running. 
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 Level Crossing Barr ier  

Skill:   i) Using a Motor output with 
 Power control. 

ii) Testing the outputs by using 
the monitor screens. 

Primary Mimic Disc 
Levcrosp 
Resources 
Inputs 1 & 2 – switches 
Motor a – motor 
Other outputs - 6V bulbs 

 

1. Display the mimic with labels and build this 
program to operate the Level Crossing gate. 
(Remember you can copy flowcharts). 

 
2 The inputs 1 and 2 are the approach and pass 

switches and motor ‘a’  operates the barrier. 
 
3 Power control of the motor  is only possible 

if the program has been configured for a 
suitable interface.  
If this is available, the  
motor speeds can be 
altered in steps of 10%.   
Use the prompts: 
Turn Motor a fd 20 (for 20%). 
 

4 Developments to the program: 
i) Operate the lights to control the traffic 

on the road. This could be another 
sub-routine. 

 
ii) Train signal lights should only go 

green if it is safe. 
 
 

1 You will need the program configured for 
the right interface and remove the tick 
from ‘Simulate’  in Control menu. 

2 Do not run the program but open a monitor 
window and click on the output numbers or 
motor letters. These icons act as toggle 
switches (left & right mouse button on 
motor). 

3 Dragging the motor sliders will also vary 
the motor output power.  

  

Testing your  model on the inter face 

Sub 2(open)

Turn
 Motor a rev 

Delay 0.5

Turn
 Motor a off 

Stop

Sub 1(close)

Turn
 Motor a fd 

Delay 0.5

Turn
 Motor a off 

Stop

Start

Is Input 1 on

Sub
 1(close)

Is Input 2 on

Sub 2(open)

YES

YES

NO

NO

Motor
 a fd 20%
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Logging the Level Crossing 

 

In this example Flowol Graph is monitoring 
some of the digital inputs and outputs. 
 
1 The frequency graph of Input 1 shows 

how regularly the trains approach. 
 
2 The approach and pass switches can be 

logged separately. 
 
3 The response of the barrier motor A is 

shown both forward and reverse. The 
height of the ‘blocks’  can indicate the 
motor power. 

 
4 The two train signal lights could also be 

logged (check the outputs on your 
mimic). 

Skill: 
Use Graphs to data log the inputs, 
outputs and motors. 

Building Up the Graph Axes 
1. Open the Graph window 

from Window or Graph 
menu [‘Show Graph’ ]. 

2. Click on the icon of your first 
variable, turning it yellow, 
then click on the graph 
window. 

3. Suitable axes will appear and 
also grey strips ’gutters’  
above and below the axes. 

4. Further variables can then be 
selected and added to the same 
set of axes (from the same 
variables block) or given new 
axes by clicking on a gutter 
(pointer will change). 

 

5. There are a maximum of 6 sets of axes available, of which: 2 can be analogue (see later), 2    
can be frequency graphs, 4 for digital inputs, 4 for digital outputs, 4 for motors. 

6. Data is automatically logged even when not being displayed on axes. 
7. The logging time is initially 2 minutes and will keep doubling up if it has not been  

specified in the ‘Time Parameters’ , accessed from the Graphs menu. 
8. The size of the graph window can be changed by dragging the bottom r ight hand  

corner . The position of the graphs window can be moved in the usual way. 

Pr imary Mimic Disc 
Levcrosp 
Resources 
Level crossing model 
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Auto-Home 

Skill:  
 Using Sensors 

Primary Mimic Disc 
AutohP 
Resources 
AutoHome model 

Load the Autohome mimic with labels. 
Note: Input 3 for the Sun  (the light level) 
          Input 4 is the temperature. 

Using 
temperature: 
Build this 
flowchart to        
control the 
electric fire 
(output 5). 
Run in simulate 
mode and click 
on the 
thermometer. 
 

 
Automatic lights: 
Could also be done in a similar way by using input 3 
(click on the Sun). 
 
The Garage Door: 
The digital input switches could be used to open 
and close the garage door. This is similar to the 
flowcharts needed to operate the barrier crossing. 
 
Automatic Blinds:  
Two more sub-routines (BlindCl) and (BlindOp) 
can be drawn to control the blinds.  The ‘master 
program’  shown here on the right, uses input 3 
again. 

 
 

Input 5 could act as a secur ity sensor to detect a person near by. 
How could this be used?  
 
Perhaps the door  bell push (input 6) should only work at daytime. (AND) 
Add text to the Flowchart and remember to save your  program. 

Using more inputs. 

Start

Is Input 3 off

Sub
 3(blindCl)

Is Input 3 on

Sub
 4(blindOp)

Blind Control

YES

YES

NO

NO

 

 

Start 

Is Input 4 on 

Turn 
Output 5 on 

Turn 
Output 5 off 

Fire 

YES 
NO 
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Data Logging with Flowol 

Skill: 
Use ‘Graphs’  to plot information 
from analogue inputs. 

Resources 
Analogue sensor 1 - Temperature 
Analogue sensor 2 - Light 

 

Setting Up ‘Graphs’  
1 Check that Flowol is configured for a suitable analogue interface. 
2 Un-tick Simulate in the control menu. 
3 Build up the graph axes as explained on the ‘Logging the Level Crossing’  page. 
     If you wish, select the logging time from: ‘Time Parameters’  in the Graphs menu. The time 

axis will otherwise default to 2 minutes and keep doubling up. When you stop the program 
in the default setting, the results will fill the time axis. 

4 Re-size the graph window by dragging the bottom right corner, and position it in the usual 
way. 
Note:  Clicking on RUN will star t the logging; a flowchart is not needed. 

5 Selecting ‘Values’  from the Graphs menu allows a line to be scanned across the graphs to show 
the analogue values. These are displayed in either of the monitor windows. 

6 Change the feature of the y-axis by clicking 
to the left of the y-scale: 

i) Use the left mouse button to ‘cycle’  the 
calibrations for different variables on those 
axes. 

ii) Use the right mouse button to change the 
range displayed. 

 
Example: Logging the Classroom 
·  The Temperature from val 1 and the 

brightness val 2 are on different axes. 
·  Temperature is calibrated (–10 to 110 oC). 
·  After the readings were taken, the 

temperature range was changed to10 - 40oC. 
·  The automatic light (output 6) could be 

controlled with a flowchart and monitored.  It 
comes on if brightness is less than 30%. 

 

Calibrating the Sensors 
The readings from the analogue sensors are displayed in the 
monitor windows, and are usually given as %. 
If the program is configured for an interface (from the 
control menu) then calibrated values from some of the 
sensors can be displayed.  To do this, select ‘Sensors’  from 
the ‘Graph’  menu.  Drop down the menu near the val 
readings and select the sensor. 
 (Some interfaces detect the sensors automatically). 
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 Level Crossing Barr ier  

Skill:   i) Using a Motor output with 
 Power control. 

ii) Testing the outputs by using 
the monitor screens. 

Secondary Mimic Disc 
Levcross 
Resources 
Inputs 1 & 2 – switches 
Motor a – motor 
Other outputs - 6V bulbs 

 

1. Build the program for the Level Crossing. 
(Remember you can copy flowcharts). 

 
2 The inputs 1 and 2 are the approach and pass 

switches and motor ‘a’  operates the barrier. 

3 Power control of the motor  is possible if 
the program has been configured for an 
appropriate interface.  
If this is available, the  
motor speeds can be 
altered in steps of 10%.   
Use the prompts: 
Turn Motor a fd 20 (for 20%). 

4. Developments to the program: 
iii) Operate the lights to control the traffic 

on the road. This could be another sub-
routine. 

iv) Input 3 is a switch on the barrier post 
that is ON when the gate is closed. Use 
this switch (feedback) to stop the gate 
motor at the right time. 

v) Train signal lights should only go green 
if it is safe (use Input 3). 

vi) Flashing red traffic lights might need 
variables – see later. 

 
  

Testing your  model on the inter face.  
1 You will need the program configured for 

the right interface and remove the tick 
from ‘Simulate’  in Control menu. 

2 Do not run the program but open a monitor 
window and click on the output numbers or 
motor letters. These icons act as toggle 
switches (left & right mouse button on 
motor). 

3 Dragging the motor sliders will also vary 
the motor output power.  

 
 

Sub 2(open)

Turn
 Motor a rev 

Delay 0.5

Turn
 Motor a off 

Stop

Sub 1(close)

Turn
 Motor a fd 

Delay 0.5

Turn
 Motor a off 

Stop

Start

Is Input 1 on

Sub
 1(close)

Is Input 2 on

Sub 2(open)

YES

YES

NO

NO

Motor
 a fd 20%
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Logging the Level Crossing 

 

In this example Flowol Graphs is monitoring 
some of the digital inputs and outputs. 
 
1 The frequency graph of input 1 shows how 

regularly the trains approach. Several 
inputs can be ‘adjacent’  or ‘stacked’  (click 
left of y-axis). 

2 The approach and pass switches can be 
logged separately. 

3 The barrier motor graph shows the forward 
and reverse. The ‘block’  height indicates 
the motor power. 

4 The train signal lights are also logged. 

Skill: 
Use Graphs to data log the 
inputs, outputs and motors. 

Building the Graph Axes 

1. Open the Graph window   
from Window or Graph 
menu [‘Show Graph’ ]. 

2. Click on the icon of your 
first variable, turning it 
yellow, then click on the 
graph window. 

3. Suitable axes will appear 
and also grey strips 
’gutters’  above and below 
the axes. 

4. Further variables can then 
be selected and added to 
the same set of axes (from 
the same variables block) 
or given new axes by 
clicking on a gutter (the 
pointer will change). 

 

5. There are a maximum of 6 sets of axes available, of which: 2 can be analogue (see later), 2 
can be frequency graphs, 4 for digital inputs, 4 for digital outputs, 4 for motors. 

6. Data is automatically logged even when not being displayed on axes. 
7. The logging time is initially 2 minutes and will keep doubling up if it has not been specified 

in the ‘Time Parameters’ , accessed from the Graphs menu. 
8. The size of the graph window can be changed by dragging the bottom right hand corner. The 

position of the graphs window can be moved in the usual way. 

Secondary Mimic 
Levcross 
Resources 
Level crossing model 
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Auto-home 

Skill: Analogue sensors: 
i) Respond to analogue inputs. 

 ii) Calibrate analogue inputs. 

Secondary Mimic 
Autohome 
Resources 
AutoHome model 

Values from the analogue sensors in this 
mimic are shown as: -  
Val 1 for temperature. 
Val 2 for the light level. 
Using temperature: 
1 Build this flowchart 

to control the 
electric fire. 

2 Build a similar chart 
to work the fan if too 
hot. 

Using Br ightness: 
3 Automatic lights 

could also be done 
in a similar way (use 
val 2). 

Automatic Blinds:  
4   (Show labels on the mimic to identify the outputs and motors). 

Two sub-routines (BlindCl) and (BlindOp) similar to those needed to 
operate the barrier crossing can be adapted to control the blinds.  The 
‘master program’  shown here on the right uses val 2. 

The Garage Door: 
5   The digital input switches could be used to open and close the garage 

door, again similar to the barrier-crossing gate. 
6   Input 3 could act as a secur ity sensor to detect a person near by. How 

could this be used?  
7   Perhaps the door bell push (input 4) should only work in daylight! 

 
Add text to the Flowchart and remember to save your  program. 
 

 

Changing the Analogue sensor  readings in Simulation mode: 
Click on the val readings on the mimic with left mouse button to 
increase the value by steps of 10. Use the right button to decrease. Or 
click on the monitor window to �toggle� the analogue reading between 
min. and max. values. 
 
Calibrating the Sensors 
The readings from the analogue sensors are displayed on the mimic 
and the monitor windows, and are usually given as a percentage. 
If the program is configured for an interface (from the control menu) 
then calibrated values from some of the sensors can be displayed.  
Select ‘Sensors’  from the ‘Graph’  menu. Drop down the menu near 
the val readings and select. (Some interfaces will detect the sensors 
automatically). 
 

 

Start

Is Val 1 < 30

Turn
 Output 5 on

Turn
 Output 5 off

Fire

YESNO

Start

Is Val 2 < 50

Sub
 1(BlindCl)

Sub
 2(BlindOp)

Is Val 2 > 50

Blind control

YES

YES

NO

NO
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Data Logging with Flowol 

Skill: 
Use ‘Graphs’  to plot information 
from analogue inputs. 

Secondary Mimic 
Autohome 
Resources 
Analogue sensor 1 – Temperature 
Analogue sensor 2 - Light 

 

Setting Up ‘Graphs’  
1 Check that Flowol is configured for a suitable analogue interface. 
2 Un-tick Simulate in the control menu. 
3 Build up the graph axes as explained on the ‘Logging Level Crossing’  page. 

i) Choose Analogue inputs. 
ii) All analogue values can be on the same axes but two sets of axes are available. 
iii) Calibrate the sensors from the ‘Sensors’  window, (explained on previous page). 
iv) If you wish, select the logging time from: ‘Time Parameters’  in the Graphs menu. 

The time axis will otherwise default to 2 minutes and keep doubling up. When you 
stop the program in the default setting, the results will fill the time axis. 

4 Re-size the graph window by dragging the bottom right corner, and position it in the 
usual way. 

 

Note:  Clicking on RUN will star t the logging; a flowchart is not needed. 
 

5 Selecting ‘Values’  from the Graphs menu allows a line to be scanned across the graphs to 
show the analogue values. These are displayed in either of the monitor windows. 

 
6 Change the feature of the y-axis by 

clicking to the left of the y-scale: 
i) Use the left mouse button to ‘cycle’  the 

calibrations for different variables on 
those axes. 

ii) Use the right mouse button to change the 
range displayed. 

 

Example from Autohome:   
(a) The Temperature from val 1 and the 

brightness val 2 are on different axes. 
(b) Temperature is calibrated (–10 to 110 oC). 
(c) After the readings were taken the temp. 

range was changed (10 to 40oC). 
(d) The automatic light (output 6) is monitored.  

It comes on if brightness is less than 30%. 

Other  Projects: to monitor and/or control 
1 Automatic greenhouse. 
2 The gerbil in its cage. 
3 A baby’s play area. 
4 Conditions in a kitchen. 
5 Solar water heating panel. 
 

Saving and Pr inting Graphs (see Page 33). 
1. Choose ‘Save as Graph’  from the graph 

menu. 
2. Choose ‘Print Graph’  from the file menu. 
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The Greenhouse 

Skill:  
i) To monitor and control a 

scientific investigation. 
ii) Test mode. 

  

Secondary Mimic 
Greenhouse 
Resources 
Model greenhouse or propagator 
With heater (bulb), fan (motor) 

Values from the analogue sensors in this 
mimic are shown as: -  
 Val 1 for temperature 
 Val 2 for the light level 

 

Start

Is Val 2 < 40

Turn
 Output 6 on

Turn
 Output 6 off

Automatic Light

YESNO

1. Build this chart to 
control the light. 

 
2 Click on the val 2 

reading for the 
simulation 

 
3 Draw a similar 

chart to control the 
heater (use val 1 
& out 5). 

  

4 Draw another similar flowchart to operate the sprinkler with the sensor Input 1. A motor 
(output b) has been used so that any real pump  (e.g. a car windscreen washer pump) can be 
adjusted with the power control if a control box is being used. 
Now construct a moisture sensor. Test the depth it should be placed. 

 
5 Temperature control (val 1) should also be maintained with ventilation (window or fan). 

Draw flowcharts to open and close the window (motor a).  Two sub-routines and a main 
routine are needed (similar to those used in the Level Crossing Barrier). 
OR control a fan with a flowchart similar to those used earlier. 

 
6 After testing your program in simulation mode, connect it to your propagator and test the 

function of your sensors and outputs. 
 
7 Set up ‘Graphs’  to monitor the analogue inputs and have a test run. 
 
8 It might be possible to operate two propagators to compare different conditions. 
 
9 Write a report of your investigation. You should be able to export the flowchart, graph and 

possibly the mimic to your final document. See page 34. 
 

To check the values of the analogue readings tick the box for 
test mode on the monitor screens. If Flowol is configured for your 
interface and not in simulate mode, then the readings will be 
displayed. This is useful to check the threshold values when 
creating the flowchart. 
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Car Park Barr iers 
Skill: 
 Using Variables 
 Speeding up the flowchart.  

Secondary Mimic 
Carpark 
Resources 
4 Input switches 
2 Output motors 
1 Output bulb 

A variable is a letter that can be 
assigned a value:   (Let n = 10). 
 
Variables can be subtracted or added 
to:            (Let n = n + 1). 
 
Variables can be subtracted: 
               (Let n = n - y). 
 
A variable can be checked in a 
Decision box. 

 

The flowcharts for each car park barrier are 
similar to that for the level crossing gate. 
 
To count the cars in and out, the variable 
‘n’  is counted up when the ‘ in’  barrier closes 
and ‘n’  counted down by the ‘out’  barrier. 
 
The ‘Full’  sign can be triggered by this 
variable in a separate flowchart. 
 
The value of the variable can be observed by 
opening Variables from the Window menu. 

 

 

To make the car park most effective, the ‘ in’  
barrier should only open if there is a parking 
space.  The ‘master in’  program therefore has 
an AND situation created by two decision 
boxes (Is input 1 on AND is n < 4). 
 
Save and Pr int your program.  

Start

Sub 1(IN up)

Sub 2(IN dn)

Is Input 1 on

Is Input 2 on

Is n < 4

In barrier

Is there
space?

YES

YES

NO

NO

YES

NO

Sub 2(IN dn)

Turn
 Motor a rev 

Delay 1

Turn
 Motor a off 

Let
 n = n + 1

Stop

Sub 4(OUT dn)

Turn
 Motor b rev 

Delay 1

Turn
 Motor b off 

Let n = n - 1

Stop

Start

Is n > 3

Turn
 Output 5 on

Turn
 Output 5 off

FULL sign

YESNO

Let n = 1

Let
 n = n + 1

Let
 n = n - y 

Is n > 20

To Run the Flowchart Faster  
i) Close the mimic, monitor and variables windows. 
ii) Mac/PC: change the colour of the active box and lines to ‘None’ . 
iii) PC: minimise the window. 
iv) Acorn RISC OS: close down the window. You can Run and Stop the 

program from the Flowol icon on the icon bar. 
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A Fairground Ride  

1 To avoid rapid changes in the 
movement of a fairground ride the 
motor speed is changed gradually. 

2 The program uses the variable ‘n’  
to change the speed in ten steps. 

3 Remember to construct the sub-
routines before the main program. 

4 Open the large monitor window 
to observe the motor speed 
changing. 

5 Emergency Stop.  

Resources 
Ferris wheel 
Input 1 – switch 
Motor a – 6V motor 
Input 2 – pressure mat 

The ‘Stop All’  will 
stop all of the 
flowcharts in that 
program. 
The pressure mat input 
2 could trigger this. 

Other  Uses for  a var iable: 

1 Flashing Traffic L ights  
For the level crossing barrier. 
 
The flashing lights stopping 
the cars need to start near the 
beginning of the sequence 
and only stop at the end. 
 
A separate flashing routine 
similar to the one shown, can 
be triggered by the variable n 
= 1. 
 
The variable can be defined 
in the main routine. Let n = 1 
near the beginning and Let n 
= 0 at the end. 

2 Repeating a Sub-routine 
Beep at pelican crossing. 
 
Flowol can define the 
repetition of sub-routines 
from the main procedure 
e.g. 
 
 
 
Routines are normally 
repeated by increasing the 
variable as shown on the 
right. 

Sub 1(speedUp)

Let n = 10

Turn
 Motor a fd n%

Delay 1

Let
 n = n + 10

Is n = 100

Stop

Sub 2(slowDn)

Turn
 Motor a fd n%

Delay 1

Let
 n = n - 10

Is n < 10

Turn
 Motor a off 

Stop

Start

Is Input 1 on

Sub
 1(speedUp)

Delay 8

Sub
 2(slowDn)

Fair Ground Round

YES

NO

YES

NO

YES

NO

Start

Is Input 2 on

Stop All

YES

NO

Start

Is n = 1

Output
 3 on 4 off

Delay 0.5

Output
 4 on 3 off

Delay 0.5

Turn
 Output 4 off

YES

NO

Sub 3(Beep)

Let x = 0

Delay 0.5

Beep

Let x = x + 1

Is x > 8

Stop

YES

NO

Sub
 3(Beep) x 9

Skill 
Using a Variable to change the speed of 
the motor 
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Start

Is Input 1 on

Is Input 2 on

Motor
 a fd b fd 

Motor
 a off b fd 

Motor
 b off a fd 

YES

YES

NO

NO

The Buggy 

Skill: 
Controlling two motors in the same 
output symbol. 

Resources 
Buggy 
Motor a – 6V motor 
Motor b - 6V motor 
Input 1 – ‘buffer’  switch 

1 The movements of a buggy 
are defined as sub-routines. 

2 Each output box (symbol) 
can control 2 motors. 

3 The power control has to 
be the same for both 
motors in the same box.  
Note: if power is 50% in 
one sub., then it stays at 
that value until it is re-
defined.  

4 Build the sub-routines (reverse could also be done). 
5   The delays in the ‘ right and left’  will have to be tested for 

your particular buggy and the motor power control chosen. 
 

Obstacle Course:  
1 Build a master program to define the path needed to be taken around a course. 
2 An emergency stop, similar to that on the fairground ride, could be triggered with a 

‘buffer switch’  (Input 1) on the front. 

Random Mover: (Cleaning the carpet!) 
1 Build a sub-routine of the movement needed when the 

buggy hits an obstacle. (The one shown is only one 
possibility). 

2 Build the master program to trigger this routine. 
3 You could have two different switches on the front!  

L ine Follower:   
This flowchart could 
be one version of a line 
follower.  The light 
sensors inputs 1 and 2 
would have to be on 
either side of a dark 
line. 
It might be an 
improvement to use 
analogue sensors and 
compare their values as 
explained in the Solar 
panel. 
  

Save and Pr int  
your  programs. 

Start

Sub
 1(Forward)

Is Input 1 on

Sub 6(avoid)

Sub 2(stop)

Sub
 5(reverse)

Delay 2

Sub 4(left)

Stop

Sub
 6(avoid)

YES

NO

Sub 1(Forward)

Motor
 a fd b fd 

Stop

Sub 2(stop)

Motor
 a off b off 

Stop

Sub 3(right)

Motor
 a fd b rev 

Delay 2

Motor
 a off b off 

Stop

Sub 4(left)

Motor
 a rev b fd 

Delay 2

Motor
 a off b off 

Stop
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Solar  Water  Heating Panel 

Skill: 
To compare two analogue 
inputs (a comparitor). 
Use the ‘Margin’ . 

Resources 
Val 1 and val 2 – temperature sensors 
Motor a – water pump 
Val 3 and val 4 – light sensors 
Motor b – 6V motor (turntable) 

Temperature Control:   
The flowchart below will only pump 
the water if the panel temp. (Val 1) is 
hotter than the water temperature in 
the tank (Val 2). 

Sun Seeker : 
The flowchart on the right will 
control a motorised turntable. 
The two light sensors on the front of 
the panel need to be separated by a 
piece of card to cast a shadow. 
The ‘Margin’  refers to the 
difference between the two 
analogue values (i.e. the difference 
has to be at least 5 units). 

Data Logging and 
Control. 
 
The ‘cause and effect’  is 
easily demonstrated by 
using Flowol Graphs: 
 
a. The pump motor A 

responds to the temp. 
differential. 

 
b. The ‘Sun seeker’  motor 

responds to the light 
differential. 

 
Note:  The light graph has 
been left as %. 
The temperature sensors 
have been calibrated and 
then the temperature range 
(limits) changed. 
 
Save your  Program 
 

 

Sub 2(east)

Is
 Val 4 > Val 3

Is
 Margin > 5

Motor
 b rev 20%

Turn
 Motor b off 

Stop

Sub 1(west)

Is
 Val 3 > Val 4

Is
 Margin > 5

Motor
 b fd 20%

Turn
 Motor b off 

Stop

Start

Sub 1(west)

Sub 2(east)

NO YES

YESNO

NO YES

YESNO

Start

Is
 Val 1 > Val 2

Motor
 a fd 60%

Turn
 Motor a off 

YESNO
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Using Sound with Flowol 2.81 or  above (Windows version only) 
Using sound with Flowol can give extra realism to control situations. Sound is often used to 
help the partially sighted cope more easily with automatic situations e.g. lifts.  
 
Flowol can use any sound files in a .wav format. 
 
Note: to find some sound files (in a .wav format) that already exist on your computer, go to Start�  Find or 
Search�  for Files or Folders, type  * .wav into the File Name box and click on Search or Find now.  
 
A Sound file will run for the entire length of the recording (while the flowchart continues 
through its processes) unless the flowchart stops running or it is interrupted by another 
sound file. 

 
Using sound files  
The sound files (saved in a .wav format) need to be ‘available’  for building into a procedure. 
This can be done before, or at any time whilst building your flowchart program. Up to 10 
sound files [0 to 9] can be used in a procedure.  
 
·  Select Sounds from Flowol’s Window 

menu.  
 
·  In the Sounds window click on the first 

Browse button (for Sound reference 0).  
 
·  Locate and select the previously saved 

sound file (.wav).  Click on OK for the 
sound file to be allocated to Sound 0. 

 
·  Continue to browse and select any other 

sound files needed for your procedure, (use 
each number in turn).  

 
Sound files can be added to this window 
while a procedure is being built. The Sounds 
window will automatically open when 
Sound is selected from the prompt box.   
 
Using sound in your flowchar t   
·  Select an output symbol          from the Flowol toolbar and place on the main workspace.   
 
·  Select Sound from the prompt box. 
 
·  The Sounds window will automatically 

open. 
 

·  Select the reference number for the 
sound (0 to 9) from the prompt box.  
The numbers correspond to the list in the 
Sounds window. 

 
·  Click OK on the prompt box. 

 

 

 

First 
Browse 
button 

Flowol’s  
Sound 
Reference 
number 

 

Select the 
sound file 

 

The sound 
file has been 
allocated to 
Sound Ref 0 
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The Sound file will run for the entire length of the recording (while the flowchart continues 
through its processes) unless: - 

 
a. The flowchart stops running or  
b. It is interrupted by another sound file (in any routine).  

 
Note: To discover or check the length of a recording, select Sound Recorder  from the Window menu or (if 
already open) from the icon bar. Use Open from the File menu in Sound Recorder  to load the previously 
saved  .wav file. The length of the recording time will be shown in the window. 
 
You may need to add a delay to the flowchart to enable the sound recording to finish. 

 
·  Select the delay symbol         from the Flowol toolbar and place on the main 

workspace. 
 
·  Select Delay, and then the timespan required for the recording 

to finish. Delays can be to one decimal place e.g. select 1.1, 
OK. 

 
Although flowcharts can run simultaneously, the sounds they contain cannot. If a sound is 
initiated by one routine, then it may be interrupted or cancelled out by a sound in another 
routine if the two overlap. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Start

Sound 0

Turn
 Motor b fd 

Delay 4

Turn
 Motor b rev 

Sound 1

Delay 2.5

Sound 0

Turn
 Motor b fd 

Delay 3

Turn
 Motor b off 

Delay 5

Delay 2

Stop

 

The background sound 
- Sound 0 - is 10 
seconds long.  
 
 
 
 
 
 
 
 
 
 
 
The delay after Sound 
0 has been activated is 
only 4 seconds so 
Sound 1 will interrupt 
and cancel the last 6 
seconds of the Sound 0 
recording.  
 
  

Repeat the Sound 0 
command so the 
background sound 
starts again. 
 
 
 
 
 
 
The length of the 
Sound 0 recording is 
10 seconds.  
There are two delays 
after the recording has 
started of 3 and 5 
seconds.  
To allow the recording 
to finish before stop is 
reached, a delay of 2 
seconds needs to be 
added to the end of the 
routine.  
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Recording sound files. 
·  Attach a microphone and speakers to the sound card on 

your computer.  
 

·  Open the Flowol program.  
 

·  Launch Microsoft’s Sound Recorder program by selecting Sound 
Recorder  from the Window menu. 

 
Note: once open Sound Recorder can be re-accessed from the icon bar. 

 

·  Click on the Record button to begin recording.              Make the sound into the 
microphone. Click on the Stop button when the recording is complete. 

 
Note: There are several features in Microsoft Sound Recorder that can be used to modify and 
improve your recording. Example: to delete part of a sound file, move the slider to the place in the 
file that you want to cut. From the Edit menu, click ‘Delete before Current Position’  or ‘Delete after 
Current Position’ . Save using a different file name to prevent replacing the original file. See Help 
Topics from the Help menu for more information. 

 

·  Select Save As from Sound Recorder’s File menu. Save as a  .wav file type in the 
destination of your choice.  

 
Note: Keep a note of the length of time of the recording. This information may be useful when the .wav file is 
run in a procedure. The duration time could be incorporated as part of the filename. 

 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 

Saving Flowol programs that use sound files  
When a Flowol file is saved, the information in the Sounds window is also saved (the 
location of the .wav files) but not the sound itself. If the location of a sound file is altered 
so Flowol cannot find the .wav file, there will be a ‘beep’  sound when the appropriate 
sound symbol is reached in the procedure.   
 
If you transfer or open a Flowol file on another computer, you may also need to either: 

 
·  Transfer the sound files to the location specified in the Sounds window or  
·  Use ‘Browse’  to re-locate the sound file from the Sounds window. 

 

 

 
 

Length of time of the recording 

 

Stop Play 

 
Record 

 

 
 

Slider 
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Note: it can be useful to create a folder specifically for any sound files that you wish to use in a 
Flowol program. Any sound files created or copied can then be saved or pasted into this folder. 
Using this method the location specified will always be the same.  

 
The ‘beep’  sound will also be heard if no sound file has been defined in the Sound 
window for the Sound reference number used in the flowchart. 

 
Notes: 

·  Flowol files (* .flo) produced using an earlier version of Flowol (2.80 less) can be 
opened and adapted to include sound in the files.  

 
·  Flowol files (* .flo) produced or adapted using Flowol version 2.81 or above will not 

be able to open in earlier versions of Flowol. 
 

·  Sound files cannot be transferred to the PIC chip used in the Kids Chip PIC’s 
System, FlowGo and SOLO. Sound instructions used in a Flowol program will be 
ignored when the program is run independent from the computer. 

 
 
 

Pr inting and Saving 
 

Printing the Flowchart. 
PC and Mac: Use the ‘Print…’ option in the File menu. 
The flowchart workspace is divided into three sections 
(shown by green lines). 
If only the top left-hand section is occupied, it will be 
printed in portrait format. 
If the top left and top right are occupied by the chart, then 
the printing will be in landscape format (this must be 
specified in ‘Printer Setup.’  for PC and Mac). 
If the bottom section is occupied, the entire page will be 
printed at 25% in portrait format. 
Acorn: Click menu on the Flowchart Window and 
Choose Print. 
 
Pr inting a Graph 
PC and Mac: Use the ‘Print Graph …’ option from the File menu. 
The graph orientation can be changed from the ‘Printer Setup ’ (‘Page Setup’  for Mac). 
Acorn: Click menu on the Graph Window and open the Print sub-menu.  Choose from 
‘Portrait half-page’ , ‘Portrait full-page’  or ‘Landscape’ . 
 
Saving Graphs. 
Graphs can be saved in three formats: 
SID – This type of file can be loaded into Flowol 2 again for viewing and printing.  It can 
also be used to export the data to other graphing applications e.g. Insight2. 
CSV (Comma Separated Values) – This is the best format to import the data into a 
spreadsheet or database. 
TSV (Tab Separated Values) – This is useful to import the data into a word processor as a 
table. 
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To Save the Graph. 
PC and Mac: Go to Graph menu and choose ‘Save as Graph..’  and use  the ‘Save As’   
dialogue box.  The file type is selected in the lower left hand corner of this window. 
Acorn: Click the menu on the Graph Window.  Open the Save sub-menu which will yield 
four options, the first three being SID, CSV and TSV.  Open the save dialogue box for the 
appropriate format you wish to save in.  Adjust the filename and drag the icon to the filer 
window in the usual way.  
If you only wish to save data for the traces currently displayed on the Graphs window, 
tick the ‘Chosen data’  box in the save dialogue.  If this is not ticked then data from all the 
channels will be saved. 

 
To Load Data from a previously saved SID file. 
PC and Mac:  Choose ‘Open Graph..’  option from the Graph menu and use the Open 
dialogue box in the usual way. 
Acorn:  Drag the SID file onto the Graph window. 

 
Expor ting into Documents 
 
Exporting the Flowchart. 
PC:  To export the entire flowchart to the clipboard, choose the ‘Copy flowchart’  option 
from the Edit menu. 
Paste to Microsoft Word.  Re-size and drag the image to position. 
 
To expor t a section of flowchart:  Use the Edit tool to select the area of the flowchart 
required and choose ‘Copy selection’  from the Edit menu. Paste etc as above. 
 
Mac: To export the entire flowchart to the clipboard as a PICT so it can be pasted into 
another Mac OS application, choose the ‘Copy flowchart’  option from the Edit menu. 
To export a section of Flowchart: Select the area of flowchart with the Edit tool, and 
choose ‘Copy selection’  from the Edit menu. 
Acorn:  Open the main menu over the flowchart window.  Open the ‘Save Draw’  save 
box.  If you only want to save a selected area of flowchart, highlight that area with the 
Edit tool and tick the ‘Selection’  box in the dialogue.  Drag the icon to a filer window 
or another application. 
 
Expor ting the Graph. 
PC: Choose ‘Copy Graph’  from the Graph menu.  This will place a Windows Meta Image 
onto the clipboard.  Use ‘Paste’  in the same way needed for the flowchart. 
Mac: Choose ‘Copy Graph’  from the Graph menu.  This will place a PICT image on the 
clipboard for other Mac OS applications. 
Acorn: Click menu button on the Graph Window and open the Save sub-menu.  The 
fourth option is DrawFile.  Open its save dialogue box and drag the icon to the filer 
window or other application. 

 
Expor ting a Mimic. 
PC:  With the mimic on the Flowol screen, press  ‘Print Screen Sys Rq’  to take a snapshot 
of the screen.  This will export the whole screen to the clipboard.  Paste this into Paint and 
select the mimic. This can then be copied and pasted into a Text box in a Word document. 
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Mac: To get a snapshot of the Flowol screen, press ‘Apple Key – Shift – 3’  (all three keys 
together).  This will save as a PICT file in the root folder of the hard drive which can then 
be loaded into most word processors. 
Acorn:  Load !Paint.  Open the filer window to save the image.  Open Paint’s icon bar 
menu.  Choose ‘Snapshot’ .  Change the settings in the dialogue box if desired, and then 
click on OK.  Drag a box around the area of the screen required (you may have disabled 
this).  A Save dialogue box will appear, adjust the filename and drag the icon to your filer 
window. 
 

Appendix I  PC Flowol 2 network installation advice 
Installing on every machine 
You may consider installing Flowol onto every machine individually (it’s very small, only 
about 2Mbytes).  To do this copy the contents of the CD Rom onto a network share and 
from every machine run the setup.exe program.  When prompted for the location to install  
make sure you specify the local computer’s hard drive. 
 
Manual Installation on a network server /share 
If you decide to install Flowol onto your network, you must first install onto the hard 
drive of a single machine.  Do this using the setup.exe on the CD Rom disk. Then install 
any additional mimic disks so everything can be installed onto the network in one go. 
 
Manual installation 
Flowol 2 is a very straightforward piece of software to install manually; there aren’ t lots 
of support files or any registry entries. 
 
The standalone installation installs the following files and folders into your specified 
folder: 

Flowol2.exe The main program file 
Configure.fcf The interface configuration file 
Sensors folder Support files for interfaces 
Mimics folder Flowol 2 mimics 
FTD2XX.dll  
INI Creator 

 
Place these files onto your network where the users have read-only access.  (Note the 
information on the interface configuration file below). 
 
When run, the Flowol2.exe locates the other files and folders by looking at a flowol2.ini 
file that the setup.exe placed into the Windows folder of your computer (e.g. C:\Windows 
or C:\WinNT).   
 
Your flowol2.ini file will look something like this: 
[LOCATIONS] 
SENSORS=C:\PROGRAM FILES\KEEP I.T. EASY\FLOWOL 2\SENSORS 
CONFIGURATION=C:\PROGRAM FILES\KEEP I.T. EASY\FLOWOL 2\CONFIGUR.FCF 
MIMICS=C:\PROGRAM FILES\KEEP I.T. EASY\FLOWOL 2\MIMICS 
FILEDIR=Z:\Pupils  (optional, see below) 
(Exact paths will depend on where Flowol has been installed to). 
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The flowol2.ini file references the configure.fcf file and the two folders: sensors and 
mimics.  These can be placed in different places on the network or on local machines, 
provided the flowol2.ini file is adjusted accordingly. 
 
Once the Flowol files have been placed onto a network share and the flowol2.ini file has 
been adjusted accordingly, place the flowol2.ini file into the Windows folder of every 
machine that you want to use Flowol on.  You could do this by hand, or by writing a short 
.bat file that you get the user to run the first time they use Flowol  
e.g. 

 Rem Copy flowol2.ini into the Windows folder 
 Copy \\appserver\flowol2\flowol2.ini %windir%\flowol2.ini 

 
With the Flowol files shared and the ini file adjusted and placed in the Windows folder 
everything should be working.  Check that you can open a mimic and that the interface 
setting is correct. 
 
Specifying the default folder  for  students to save their  Flowol files 
Note the FILEDIR line in the Flowol2.ini file above.  This specifies which directory will 
be shown in the File Open and Save dialogs in Flowol 2.9. 
 
If each student has a different document folder, then using an environment variable or a 
drive mapping will allow each user to see their files. 
 
The inter face configuration file (configure.fcf) 
The interface configuration file, configure.fcf specifies the default interface to use with 
Flowol 2.  This is set via the Interface dialog in the Control menu and saved to the 
configuration file by clicking on ‘Save and OK’ .  If the configuration file is placed in a 
read-only share then the users will not be able to modify the default interface.  If your 
school uses different interface setups for different machines/classrooms then it is perhaps 
better to place the configure.fcf file on the local hard disc of the machine and adjust the 
flowol2.ini file to reference it. 
 
Associating the .flo files with Flowol 2 
If you want to be able to double click on a saved Flowol file for it to start up in the Flowol 
program, it needs to be manually associated by double clicking on a .Flo file, click on the 
Other button, locate the Flowol.exe program and select �Always use this program� & OK. 
 
Automatic installation 
There are various automatic software distribution and installation tools available. Flowol 
has not been explicitly tested with any of them. 
 
Flowol 2.9 is packaged as a Microsoft Windows Installer 2.0 .msi file. Check the 
documentation with your installation tool for information on deploying an .msi file. 
 
‘Windows Installer’  at http://www.microsoft.com can provide detailed information on 
how Windows Installer files can be used.   

 
RM Connect network install 
Flowol2 is installed as normal using the Application Wizard. The only difference is that 
the Flowol2.ini file in c:\windows must be specifically excluded in the File Protector. (Do 
not have the details of whether this is done just in the package or on each workstation.) 
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Again the COM port and Interface that is saved in the configuration file (referenced by 
the .ini) will not be remembered between sessions. The software should be run when 
making the session to make the initial .ini file to include in the package. 

 
Guide for  Installing on RM CC3 
1) The first step is to put an .msi into the applications area on RMPackages. (Drive Q:). 

There are two methods to do this. Either copy the Data Harvest supplied .msi directly 
or use the RM Application Wizard and WinInstall LE to generate an .msi. 

 

Copying the Data Harvest .msi directly: 
a) Log on as systemadmin (or a suitable user with access) 
b) In Windows Explorer go to RMPackages\Applications 
c) Make a new folder called “Flowol”  
d) Copy in the Flowol 2.90 setup.msi file from the Flowol CD. 

   

2) The second step is to make the shortcuts. The RM Application Wizard will do this 
automatically or the following manual method can be used. 
a) Make a subdirectory under RMPackages\Applications\Flowol called “shortcuts”  

and under there one called “Flowol” .  
Note: The exact spelling is essential. 

b) To get the actual shortcuts to install, double click on the “Flowol 2.90 setup.msi”  
from the CD or the RMApplications directory to do a temporary install. It is 
essential that you choose the “ Install for  Everyone” option during the installation. 
This will generate the shortcuts in the directory “C:\Documents and Settings\All 
Users\Start Menu\Programs\Flowol” . Copy all these shortcuts into the 
“shortcuts\Flowol”  subdirectory made above. 

 

3) The third step requires the RM Management Console. Go to Workstations, right click 
on any site and select “Update Package List”  from the popup menu. 

 

4) Go to the workstations that require this package and allocate Flowol to them. Right 
click and select Properties. Allocate from the Packages tab. 

 

5) In Resources->Program Sets add the Flowol shortcut to where required in the Start 
menu. 

 

6) The Flowol 2.90 setup.msi will configure Flowol with ‘No Interface’  selected. To be 
able to alter and save the interface configuration (when Flowol is used with an 
interface) there must be a ‘writeaccess.ini’  file under 
RMPackages\Applications\Flowol. This contains the two lines 

 

[C:\Program files\Keep I.T. Easy\Flowol\configur.fcf] 
Everyone=0x1301BF 

 

7) Reboot the required Workstations. Flowol will be available after logging in. 
 
The USB dr iver  for FlowGo and SOLO is automatically put into the package as part of 
the Flowol installation. However, the first time FlowGo or SOLO is attached to the 
workstation the “Add New Hardware”  will run. This must be done as “systemadmin”  or a 
user with equivalent access rights. 
 

At the moment the Mimics are supplied on floppy disk which do not have an .msi 
installer. To install these use the RM Application Wizard or WinInstall LE to do a before 
and after snapshot to create the msi. 
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The floppy disk installer looks for Flowol before installing the mimics so the following 
steps have to be taken. 
1) Do a temporary install of Flowol on the package-building machine. Make sure this 

has installed to the default C:\Program Files\Keep I.T. Easy\Flowol folder. 
2) Use WinInstall LE to do the before snap shot 
3) Install the mimics* . It will search for Flowol and find it at the C:\Program Files\Keep 

I.T. Easy\Flowol location. 
4) Use WinInstall LE to do the after snap shot. 

 

*Unless you want different groups of students to have access to different mimics, install all 
the mimic disks you have purchased between the before and after snapshot. 
 

Appendix I I  Using Flowol with the LEGO dacta Inter face ‘B’   
Labelling the Interface ‘B’  
Flowol is designed to respond to or control: 
8 digital inputs, labelled . . . . . . . . . . . . . .  Input 1 – 8 
4 analogue inputs, labelled . . . . . . . . . . . . .. Val  1 – 4 
8 outputs, labelled . . . . . . . . . . . . . . . . . . Output 1 – 8 
4 motors (with speed control) labelled. .  Motor A – D 
 
The LEGO interface therefore needs some  
re-labelling to make it compatible with Flowol. 

The first 4 outputs are 
labelled correctly for the 
motors A – D. 
Only these outputs will 
allow a motor to be 
reversed and have speed 
control. 

Calibrating the Temperature and L ight 
sensors. 

 

 

To calibrate a sensor, select ‘Sensors’  from the Graph menu. 
Open the menu from the ‘down arrow’  against the analogue 
input you have chosen. 
 
Choose ‘Temperature’  to give readings in Celsius and give 
the correct heading to the graph. 
 
The Light sensor gives reading as % but choosing ‘Light’  
from the drop-down menu will give the correct heading to 
a graph. 
 

All the inputs are labelled correctly for 
the digital inputs 1 - 8 (e.g. Touch 
Sensor). 

The analogue sensors (Temperature, 
Light and Angle) should be connected 
to the 4 blue inputs only, which need to 
have additional labels: Val 1 to Val 4. 

All eight outputs will need to be re-
labelled: Outputs 1 – 8 to operate 
the Lamp, Buzzer and Motor 
(forward direction only). 
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Using the Angle Sensor  with Flowol 
The Angle Sensor gives analogue readings  
Val: 0, 25, 65, 50, (approximately) for each 
quadrant as shown. 
If instructions with combinations of > and/or  
< 20, 60, 40 etc. are used, Flowol can detect 
the position of a garage door or car park 
barrier etc. or count the number of revolutions 
of an axle. 
Note:  If the rotation is too fast the program 
might not detect the change (i.e. gear rotation 
down and Turn Motor a fd 10% etc). 
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E.g. If we consider the rotation starting from the top, these sections of flowcharts, 
below, should stop the motor ‘a’  in the different sectors in the first quadrant. 

If the rotation is more than 90o, use another flowchart 
to count the quadrants with variable ‘n’  

Changing this value will allow 
many rotations to be detected.  
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